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Counting

Chisenbop Finger Counting

Chisenbop is a method of doing basic arithmetic using your fingers. It is attributed to the Korean tradition, but it is probably extrememly old, as the soroban and abacus use very similar methods. Probably these other devices were derived from finger counting.
For more information on Chisenbop, try one of the following sites:

http://klingon.cs.iupui.edu/~aharris/chis/chis.html

http://www.mathematicsmagazine.com/5-2003/Chisenbop_5_2003.htm
http://mathforum.org/library/view/7129.html

Counting
—The tutorial below is from the following site: http://klingon.cs.iupui.edu/~aharris/chis/chis.html

The key to finger math is understanding how to count. The right hand stands for the values zero through nine. Each digit counts as one, and the thumb counts as five. Here’s an illustration: 
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	0
	1
	2
	3
	4


As you can see, digits 0 through four are pretty self explanatory. The thumb counts as five, so here’s how to represent five through nine: 
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	5
	6
	7
	8
	9


The left hand represents multiples of ten, with the right thumb representing 50. Here’s how the left hand works: 
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	0
	10
	20
	30
	40
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	50
	60
	70
	80
	90


**************************

Abacus

The abacus is an ancient calculator and still very useful for persons whose ability to write mathematics may be limited.

The PBS site below www.pbs.org/teachersource/mathline/concepts/asia/activity1.shtm) is a good source for more information and teaching ideas about the abacus, as is Abacus: Mystery of the Bead (http://webhome.idirect.com/~totton/abacus/pages.htm#Soroban1)

The Texas School for the Blind and Visually Impaired site (www.tsbvi.edu/Education/
abacus.htm) has quite a bit of abacus information. The TSBVI site is also a very good general resource for teaching math to blind students.

Displaying Numbers on the Japanese Abacus
—The following is taken from the PBS Teacher Source Web site: http://www.pbs.org/teachersource/mathline/concepts/asia/activity1.shtm

When you show a number on the abacus, you move beads to the crossbar. When beads are moved away from the crossbar, they are canceled. For example, when a lower bead is canceled, it is lowered from the crossbar and an upper bead is canceled when it is raised from the crossbar. Remember the upper bead represents five units and each lower bead equals one unit.

Let’s show 63 on the abacus.
* Go to the ten’s place. Lower an upper bead to the cross bar. This represents 50. Move one lower bead up to the crossbar. This shows 60. 

* Move to the one’s column and move 3 lower beads up to the cross bar. This shows 63 (60 + 3 = 63).
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Let’s show 672 on the abacus.
* Move to the hundred’s column. How many beads should you lower and/or raise to represent 600? 

* Move to the ten’s column. How many beads should you lower and/or raise to represent 70? 

* Move to the one’s column. How beads should you lower and/or raise to represent 2?
Your abacus should look like this picture.
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The Japanese Soroban Abacus
Taken from http://webhome.idirect.com/~totton/abacus/pages.htm#Soroban1
Simple addition & subtraction 
When using a soroban to solve problems of addition and subtraction, the process can often be quite straightforward and easy to understand. In each of the six examples below beads are either added or subtracted as needed. 
Simple Addition 
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Simple Subtraction 
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But what happens when an operator is presented with a situation where rods don’t contain enough beads to complete addition or subtraction problems in a simple, straightforward manner? This is where the real fun begins. In the next section we’ll see how the use of complementary numbers and a process of mechanization allows an operator to add or subtract sets of numbers with lightning speed.

COMPLEMENTARY NUMBERS

A Process of Thoughtlessness 

In competent hands, a soroban is a very powerful and efficient calculating tool. Much of its speed is attributed to the concept of mechanization. The idea is to minimize mental work as much as possible and to perform the task of adding and subtracting beads mechanically, without thought or hesitation. In a sense to develop a process of thoughtlessness. With this in mind, one technique employed by the operator is the use of complementary numbers with respect to 5 and 10.

· In the case of 5, the operator uses two groups of complementary numbers:
 4 & 1 and 3 & 2.

· In the case of 10, the operator uses five groups of complementary numbers:
9 & 1,   8 & 2,   7 & 3,   6 & 4,   5 & 5. 

With time and practice using complementary numbers becomes effortless and mechanical. Once these techniques are learned, a good operator has little difficulty in keeping up with (even surpassing) someone doing the same addition and subtraction work on an electronic calculator.
The following examples illustrate how complementary numbers are used to help solve problems of addition and subtraction. In all cases try not to think beforehand what the answer to a problem will be. Learn these simple techniques and and you’ll be amazed at how quickly and easily correct answers materialize, even when problems contain large strings of numbers.

Addition

In addition, always subtract the complement.
Add:  4 + 8 = 12

Set 4 on rod B. 
Add 8. 

Because rod B doesn’t have 8 available, use the complementary number.

The complementary number for 8 with respect to 10 is 2. 
Therefore, subtract 2 from 4 on rod B and carry 1 to tens rod A. 
This leaves the answer 12.  (Fig.8) 
4 + 8 = 12 becomes 4 - 2 + 10 = 12 
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Fig.8  
	 
	 Similar exercises:
4+9
4+7
4+6
3+9
3+8
3+7
2+9
2+8
1+9
9+9
9+8
9+7
9+6
8+9
8+8
8+7
7+9



Add:  6 + 7 = 13

Set 6 on rod B. 
Add 7. 

Once again subtract the complement because rod B doesn’t have the required beads.

The complementary number for 7 with respect to 10 is 3. 
Therefore, subtract 3 from 6 on rod B and carry 1 to tens rod A. 
This leaves the answer 13.  (Fig.9)

6 + 7 = 13  becomes 6 - 5 + 2 + 10 = 13
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Fig.9
	 
	 Similar exercises:
5+6
5+7
5+8
5+9
6+6
6+8
7+6
7+7
8+6



Subtraction

In subtraction, always add the complement.
Subtract:  11 - 7 = 4 

Set 11 on rods AB. 
Subtract 7. 

Since rod B only carries a value of 1 use the complement .

The complementary number for 7 with respect to 10 is 3.  

(Please note: In subtraction the order of working the rods is different from that of addition.)

Begin by subtracting 1 from the tens rod on A, 
then add the complementary 3 to rod B to equal 4.  (Fig.10)

11 - 7 = 4 becomes 11 - 10 + 3 = 4

	[image: image32.png]


Fig.10
	 
	 Similar exercises:
10-6
10-7
10-8
10-9
11-8
11-9
12-8
12-9
13-9
15-9
15-8
15-7
15-6
16-9
16-8
16-7
17-9



Subtract:  13 - 6 = 7

Set 13 on rods AB. 
Subtract 6. 

Use the complement again.

In this case, the complementary number for 6 with respect to 10 is 4. 
Begin by subtracting 1 from the tens rod on A, 
then add the complementary 4 to rod B to equal 7.  (Fig.11)

13 - 6 = 7 becomes 13 - 10 + 5 - 1 = 7
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Fig.11
	 
	 Similar exercises:
11-6
12-6
12-7
13-7
13-8
14-6
14-7
14-8
14-9



The Order of the Rod

This is where students new to soroban can make mistakes. In each of the above examples the operation involves using two rods, a complementary number and a carry over from one rod to another. Notice the order of operation. 

For Addition

1. First subtract the complement from the rod on the right. 

2. Then add a bead to the rod on the left. 

For Subtraction

1.  First subtract a bead from the rod on the left. 

2.  Then add the complement to the rod on the right. 

This is the most efficient order of operation. When attention is finished on one rod the operator moves on to the next. There is no back and forth between rods. This saves time.

Manipulatives

Publisher:

The American Printing House for the Blind, Inc.

www.aph.org
1839 Frankfort Avenue
P.O. Box 6085
Louisville, Kentucky 40206-0085
Phone: 800-223-1839

Fax: 502-899-2274
For customer service:

info@aph.org
Products:

· Braille rulers and yardsticks

· Braille and large-print protractor
· Brannan Cubarithm slate and cubes rubber frame only
· Brannan Cubarithm slate and cubes plastic cubes only
· Cranmer abacus
· Cranmer abacus: optional coupler
· Embossed graph sheets

· Fractional parts of wholes set

· Geometry Tactile Graphics Kit

· Graphic aid for mathematics (rubber/cork board)

· Graphic art tape (for making lines on cork boards)
· Metric-English measurement ruler with caliper slide
· Number lines

· Orion TI-34 Talking Calculator
Description:

APH carries many products to assist persons who are blind or visually impaired. Check also for such products as TalkingTyper (to teach keyboarding) and APHont (a free font designed for low vision users).

*****************

Publisher:

Maxi-Aids, Inc.

www.maxiaids.com
42 Executive Blvd.

Farmingdale, NY 11735
Phone: 800-223-1839

Fax: 1-631-752-0689

For customer service:

on-line form
Retail Costs:

Magnetic Alphaboard

Item#: 17825 
Price: $15.95
Raised Line Drawing Kit (Sewell)

Item#: 2053406

Price: $28.95
Replacement Sheets (about 70 sheets)
Item#: 2022801

Price: $5.99

Description:

Maxi Aids carries a wide range of products of interest to persons with various disabilities. You can order on-line.

Math Window

Publisher:

Wolf Products

www.mathwindow.com
106 Purvis Road

Butler, PA 16001

Phone: 724-285-5428

For customer service:

wolfproducts@mathwindow.com
Retail Cost:

Braille basic kit:  $120.00

Braille algebra add-on:  $65.00

Braille geometry kit: $400

Large print basic math: $140

Large print algebra add-on: $90

Description:

Math Window consists of a magnetic board and tiles that allow blind students to build and solve math problems. The tiles combine printed numerals and symbols for the sighted instructor, along with Nemeth Code for the blind student. Math problems can be configured in the same linear or vertical forms that sighted students are taught.

The Math Window Algebra Add-On Kit contains all the letters, symbols, and operations needed for students to understand and progress through high school algebra.

Sighted tutors can use Math Window with very little instruction, and Braille-readers can construct their own math equations.
How to construct a problem

Math Window is designed for ease in locating and moving the pieces so the student can quickly construct and solve a problem. Rather than picking up each piece and placing it in the desired location, we recommend sliding the pieces from place to place.

Linear Arrangement

Addition, Subtraction, Multiplication, and Division:

Slide the first numeral of the problem into an empty section of the Window. Next, slide the operation sign into position, followed by the second numeral in the problem. Place the equal sign after the last numeral, and the problem is ready to solve.

[image: image34.png]
Spatial Arrangement

Addition and Subtraction:

Slide the first numeral into an empty section of the Window. Next, slide the second numeral under the first. The addition sign or subtraction sign is located in front of the last numeral, in the next space to the left of the outermost column. A separation line is then slid in place under the problem. (The separation lines vary in length to accommodate the variety in problems being solved.)
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Multiplication:

Similar to addition and subtraction, except the multiplication sign is located directly in front of the multiplier.
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Division:

The division symbol is placed between the divisor and the dividend. A separation line is slid above the dividend and begins in the same column the division symbol is located.

[image: image37.png]
When solving a division problem, we recommend teaching the student to “bring numerals down” within the problem by sliding numerals from the outside perimeter of the window and placing them directly below their respective numerals in the dividend. Do not slide numerals from the dividend. This can lead to confusion when working larger problems.

How to construct fractions

Simple Fractions
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Mixed Numbers
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Complex fractions
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Math Braille

Nemeth

The primary system of math Braille in the United States is Nemeth. Nemeth Braille was developed by Dr. Abraham Nemeth in the 1940s, originally for his personal use, and was adopted officially into the Braille code in 1952 by the Braille Authority of North America (BANA).
Nemeth Braille uses the standard Braille symbols to convey mathematics and can be used from the most basic to the highest levels of math. Because it uses the same 63 cells that make up literary Braille, it can be used with refreshable Braille displays.

The downside with Nemeth is that it is extremely complex, expensive to produce, and difficult to read. Braille users who did not learn Nemeth as part of their K–12 education rarely become proficient in its use.

DotsPlus

In the 1990s, Dr. John Gardner developed the DotsPlus system for rendering math into a combination of Braille and graphical symbols.
Dr. Gardner, who lost his vision later in life, found Nemeth cumbersome and difficult to learn. As a working physicist who had spent much of his life doing math visually, he also wanted to maintain the spatial information inherent in standard print mathematics.

DotsPlus looks much like print math and is not hard for a Braille reader or a sighted teacher/tutor to learn to read.

The combination of symbols and Braille makes printing DotsPlus somewhat challenging. To solve this problem, Dr. Gardner developed the Tiger embosser, which remains the only way to emboss DotsPlus math.

Number Systems Compared

	System
	1
	2
	3
	4
	5
	6
	7
	8
	9
	0

	literary
	#a
	#b
	#c
	#d
	#e
	#f
	#g
	#h
	#i
	#j

	Nemeth
	#1
	#2
	#3
	#4
	#5
	#6
	#7
	#8
	#9
	#0

	DotsPlus
	*
	<
	%
	?
	:
	$
	]
	\
	[
	+


Nemeth Code Cheat Sheet

	Meaning
	Braille Sign
	Braille Example
	Print Meaning

	0
	0
	#0
	0

	1
	1
	#1
	1

	2
	2
	#2
	2

	3
	3
	#3
	3

	4
	4
	#4
	4

	5
	5
	#5
	5

	6
	6
	#6
	6

	7
	7
	#7
	7

	8
	8
	#8
	8

	9
	9
	#9
	9

	baseline indicator
	"
	#2x^2"y
	2x2y

	brackets closing
	@)
	@(#0@)
	[0]

	brackets opening
	@(
	@(#0@)
	[0]

	Capital sign
	,
	,algebra
	Algebra

	cent sign
	@c
	#50@c
	50¢

	comma
	,
	#1,897
	1,897

	curly brackets closing
	.)
	.(#0.)
	{0}

	curly brackets opening
	.(
	.(#0.)
	{0}

	decimal point
	.
	#98.6
	98.6

	divided by
	./
	#8./2
	8 ÷ 2

	dollar sign
	@s
	@s#10
	$10

	dot (multiplication)
	*
	#5*6
	5 * 6

	English-letter indicator (lower case)
	;
	;a
	A

	English-letter indicator (upper case)
	;
	;,a
	A

	equals
	.k
	x .k #4
	x = 4

	fraction indicator closing
	#
	?1/10#
	
[image: image43.wmf]10

1



	fraction indicator opening
	?
	?5/8#
	
[image: image44.wmf]8

5



	fraction line
	/
	?1/3#
	
[image: image45.wmf]3

1



	fraction: bi-level diagonal-slash
	_/
	?1_/4#
	¼

	fraction: closing mixed-number fraction indicator
	_#
	#1_?#1/2_#
	
[image: image46.wmf]2

1

1



	fraction: complex fraction modifier
	,
	,??1/2#,/?3/4#,#
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3

2

1



	fraction: diagonal-slash fraction bar
	_/
	#1_/4
	1/4

	fraction: horizontal fraction bar
	/
	?1/4#
	
[image: image48.wmf]4

1



	fraction: opening mixed-number fraction indicator
	_?
	#1_?#1_/2_#
	 1 1/2

	greater than
	.1
	#7 .1 #4
	7 > 4

	Greek-letter indicator (lower case)
	.
	.d
	δ

	Greek-letter indicator (upper case)
	.
	.,d
	Δ

	grouping symbols
	,'
	
	

	less than
	"k
	#2 "k #6
	2 < 6

	long division
	3333

o
	  33333

16O448
	
[image: image49.wmf]448

16



	minus
	-
	#6-2
	6 – 2

	mixed number indicator closing
	_#
	#2_?#3_/4_#
	 2 3/4

	mixed number indicator opening
	_?
	#3_?#2_/5_#
	 3 2/5

	not equal to
	/.k
	#8-1 /.k #9
	8 - 1 ≠ 9

	numeric indicator
	#
	#3456
	3456

	parenthesis closing
	)
	(#0)
	(0)

	parenthesis opening
	(
	(#0)
	(0)

	percent
	@0
	#50@0
	50%

	plus
	+
	#7+9
	7 + 9

	punctuation indicator
	_
	#5_3#45
	5:45

	separation line
	3333
	 55

+ 6

3333
	55

+ 6

	subscript indicator
	;
	x;e
	xe

	superscript indicator
	^
	c^2

V^a^^2
	c2


[image: image50.wmf]2
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	times sign (cross)
	@*
	#1@*3
	1 x 3


Greek Letters in Braille, Math Context
	Letter Name
	Upper Case
	Lower Case
	Braille Upper Case
	Braille Lower Case

	alpha
	A
	α
	.,a
	.a

	beta
	B
	β
	.,b
	.b

	gamma
	Γ
	γ
	.,c
	.c

	delta
	Δ
	δ
	.,d
	.d

	epsilon
	Ε
	ε
	.,e
	.e

	zeta
	Ζ
	ζ
	.,z
	.z

	eta
	Η
	η
	.,:
	.:

	theta
	Θ
	θ
	.,?
	.?

	iota
	Ι
	ι
	.,i
	.i

	kappa
	Κ
	κ
	.,k
	.k

	lambda
	Λ
	λ
	.,l
	.l

	mu
	Μ
	μ
	.,m
	.m

	nu
	Ν
	ν
	.,n
	.n

	xi
	Ξ
	ξ
	.,x
	.x

	omicron
	Ο
	ο
	.,o
	.o

	pi
	Π
	π
	.,p
	.p

	rho
	Ρ
	ρ
	.,r
	.r

	sigma
	Σ
	σ
	.,s
	.s

	tau
	Τ
	τ
	.,t
	.t

	upsilon
	Υ
	υ
	.,u
	.u

	phi
	Φ
	φ
	.,f
	.f

	chi
	Χ
	χ
	.,&
	.&

	psi
	Ψ
	ψ
	.,y
	.y

	omega
	Ω
	ω
	.,w
	.w


Greek-letter indicator 
.
Capital sign
,
DotsPlus Symbols

	Print
	Dots Plus

	1
	*

	2
	<

	3
	%

	4
	?

	5
	:

	6
	$

	7
	]

	8
	\

	9
	[

	0
	+

	apostrophe
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	colon
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	comma
	
[image: image53.wmf],



	period
	
[image: image54.wmf].



	question mark
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	quotes
	
[image: image56.wmf]"



	semicolon
	
[image: image57.wmf];



	single quote
	`

	parentheses
	

	square brackets
	
[image: image58.wmf][]



	curly braces
	
[image: image59.wmf]{}



	angle brackets
	
[image: image60.wmf]

	and sign
	(

	asterisk
	
[image: image61.wmf]*



	at sign
	
[image: image62.wmf]@



	backslash
	
[image: image63.wmf]\



	bullet
	(

	caret
	
[image: image64.wmf]^



	divide
	(

	dollar sign
	$

	equals
	=

	not equal
	(

	approximately equal
	(

	greater than
	>

	less than
	<

	minus
	–

	multiply
	(

	number sign
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	percent
	(

	plus
	+

	slash
	
[image: image66.wmf]/



	tilde
	
[image: image67.wmf]~



	underline
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	sin
	
[image: image69.wmf]sin



	cosine
	
[image: image70.wmf]cos



	tangent
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	pi
	π

	union
	(

	intersection
	(

	null
	(

	integral
	(

	long division
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	square root
	
[image: image73.wmf]

	x squared
	
[image: image74.wmf]2

x



	angle
	(

	ray AB
	

	right angle
	(


Audio Graphing Calculator
Publisher:

ViewPlus Technology
www.viewplus.com
1853 SW Airport Ave

Corvallis, OR 97333
Phone: 541-736-1659
FAX: 541-738-6505
For customer service:

info@viewplus.com
Retail Cost:

Price for CD:  $295.00

Price for download:  $295.00

System Requirements:

· Windows XP/2000/NT
· Sound card & 256 MB of RAM

· 20 MB hard disk space

· 200 MHz processor or faster
· CD-ROM drive or network/Internet connection for download
Description
AGC is a scientific calculator that provides voiced feedback for computations, as well as audio representations of graphs. The versatile AGC can import data from Excel® or a host of other applications. Quickly and easily create tactile copies of your AGC graphs by printing directly to any ViewPlus Embosser (Tiger). 
The AGC is accessible to anyone who can use a computer, regardless of ability, allowing the user to concentrate on math, not on learning the tools to access it. 
A demo version is available on their site:

http://www.viewplus.com/products/braille-math/AGC/.
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Example: Computing and Plotting the expression y = x
You should select the Expression 1 edit box. You may reach it by moving to the Data Set 1 Tab Page and going to the first item - which is the expression box. There are a number of ways to do this. You may always press ALT-o to open the Options menu. Then arrow down to find the “Data Set 1” option and press ENTER. Focus goes to the Expression 1 edit box. 
Delete any characters in this box and type a single x. You can read the box with CTRL-r, but the box is also voiced if you press HOME to go to the first character. You may right arrow to move through and hear each character, or you may go to the end and left arrow backwards, also hearing each character. DEL deletes the character just voiced (which is just behind the insertion cursor). Backspace deletes the previous character (which is just before the insertion cursor).

If focus is in this expression box, which should now have x in it, you may calculate the data set by pressing ENTER. You will hear a short tone when the computation is finished. Note that you may also do this computation by pressing function key F4 or by going to the “Graph” menu with ALT-g and pressing ENTER on the first item - “Evaluate Expression 1”. Note that the last two options require that the source be set to Data Set 1. 
You have previously set the number of points parameter at 500, and it usually takes only a fraction of a second to compute such a simple function as y=x, so you should hear the tone rather quickly after pressing any of the options that cause the function in Expression 1 to be calculated.

You may display the graph on screen with function key F3 or by going to the “Graph” menu with ALT-g and arrowing down to “Display graph” and pressing ENTER.

Finally you may play an audio tone plot of this graph by pressing function key F5 or by going to the “Graph” menu with ALT-g, arrowing down to “Play data set” and pressing ENTER. 
Sighted people will see a graph on screen showing a straight line from the bottom left to upper right of the graph, which is correct for the expression y=x. The audio tone plot is a tone representing the y value when x is swept from its minimum to its maximum value as you hear the tone graph. Since y rises linearly, the tone of y rises linearly on a harmonic scale also. If you have set all parameters as we suggested, you should also hear some static (technically known as “white noise”) for the first half of the tone graph. You hear this because you have set the tone graph to “Play noise below y threshold” and set that threshold to zero. So you hear noise when y is less than zero and do not hear that noise when y is greater than 0. Press F5 to listen again so you can hear that there is noise for half the graph but not for the last half of the graph.

We note that the tone graph is often accompanied by an unintentional quiet high-pitched chirping sound on some computers and sound cards. It is usually minor and should just be ignored.

PIAF (Pictures in a Flash)

Publisher:

Quantum Technology

http://www.quantech.com.au/piaf
U.S. Resellers:

Humanware, Access Ingenuity

Retail Cost:

Machine:  $1395.00

Swelltouch capsule paper, 8.5" x 11", 100/box:  $130

Swelltouch capsule paper, 11" x 11.5", 100/box:  $175

Swelltouch capsule paper, 11" x 17", 100/box:  $230

Description

The PIAF machine produces high quality tactile graphics by using heat sensitive capsule paper. The raised images are easy to produce and ideal for communicating graphics and Braille to blind people. PIAF provides quick and easy access to geography, mathematics, orientation and mobility training, all science subjects, and more.

What Is Capsule Paper?

—The following discussion is taken from the Quantum Technology Website: http://www.quantech.com.au/

The Name? Capsule paper has many names. Sometimes it is known as swell paper, puff paper, pop-up paper, or even Minolta paper. It is basically all the same material with a few variations.

How’s it Made? To manufacture capsule paper, a suspension of very tiny polypropylene beads is painted onto a sheet of paper. These beads are measured in microns, so don’t try looking for them.

How’s it Work? Capsule paper works on the principal that the color black absorbs more heat. Hence, when a black line or image or dot is on a piece of capsule paper, it gets hotter than the area around it. At a certain temperature, these little beads explode, and increase their volume rather dramatically (just like making popcorn!). The result is that any black area on the paper is raised—and hey presto, you have a tactile image. Always feed the capsule paper into the photocopier in the “pass through” or “single copy” mode to avoid the capsule paper becoming stuck in the photocopier.

Please Note: The black ink used on capsule paper, must be carbon-based ink. Toner in photocopiers is carbon, some felt tip pens use carbon ink (try one and keep it with your PIAF). China markers (also called "grease pencils"), gel pens, and soft-lead pencils all work well.

MathType

Publisher:

Design Science, Inc.

4028 Broadway Ave.

Long Beach, CA 90803

USA

http://www.dessci.com/en/
Phone: 562-433-0685

FAX: 562-433-6969

General Information:

info@dessci.com
Retail Cost:

Full Price (Academic):  $57.00

Upgrade Price (Academic):  $37.00

Check with Design Science for site license pricing if order is greater then 5 units

System Requirements:

· Microsoft Windows XP, 2000, Me, 98 SE or Apple Macintosh OS 9 or OS X

· 10 to 20 MB hard disk space

· CD-ROM drive (can also download from Internet)

Description

Design Science MathType™ for Windows and Macintosh is a powerful interactive tool that will revolutionize the way you create print and web-based documents that contain math. MathType works with any word processor, presentation program, page layout program, HTML-authoring tool, plus other types of software, to create equations for research papers, class materials, web pages, slide presentations, journal articles and books.

MathType provides several options for creating accessible math content.  MathType can export mathematical expressions as images (GIF, PNG, etc.) or as MathML content.  Web content can also be created from MS Word using the MathPage export function.  Math equations created using the MathPage export are recognized by screen-reader technologies and read to the individual.  Additionally, if using Internet Explorer, the MathPlayer plug-in provides the Web page with the capacity to “speak” the equation.

Creating Math Equations for the Web

To create mathematical equations for the Web, it is first necessary to input the equations using MathType (in MS Word).  Once the mathematical expressions have been entered into MS Word, there are several options for exporting the content in a Web-ready format.

Exporting a Web page for Internet Explorer:

1.  Choose MathType from the menu bar and choose Export to MathPage.

2.  In the Title field, enter a title for the Web page.  You can also select where the resulting file will be placed.

3.  Select the radio button marked MathML using: and choose the MathPlayer (IE behavior) option from the drop-down list.

4.  Select OK.  MathType will then export the file and open the Web page within the Internet Explorer browser.

NOTE – You may receive an error message in IE that says Internet Explorer has restricted this file from showing active content.  Click in the message and choose the option Allow Blocked Content and then select Yes.  This will allow the math content to be displayed with the MathPlayer.
Exporting a Web page for multi-browser functionality:

1.  Choose MathType from the menu bar and choose Export to MathPage.

2.  In the Title field, enter a title for the Web page.  You can also select where the resulting file will be placed.

3.  Uncheck the checkbox Display in default browser.
4.  Select the radio button marked MathML using: and choose the XHTML + MathML option from the drop-down list.

5.  Select OK.
MathType will create a .xht file that contains all the page information with mathematical content.  You will need to create a hyperlink to this .xht file in order to view the relevant mathematical expressions using a Web browser.

NOTE – It is recommended to choose the “Exporting a Web page for multi-browser functionality:” option in order to best serve the widest audience possible.  This will allow individuals using specialized assistive computer technology to access the necessary math content as well as provide options to individuals using non-IE Web browsers (e.g., FireFox, Mozilla).

Considerations
When creating mathematical expressions for the Web, it is important to remember the following guidelines.

If you are exporting MathType content using the “MathPlayer (IE behavior)” option, then individuals will be able to view the content only with the Internet Explorer browser.

If you are exporting MathType content using “XHTML+MathML” option, then individuals will be able to view the content with either Internet Explorer, Netscape 7, or Mozilla/FireFox.

It will be necessary to download the appropriate MathML fonts for Netscape 7+ and Mozilla/FireFox.  You can download the appropriate MathML fonts at:

http://www.mozilla.org/projects/mathml/fonts .  The “Font Installer” is located in the right sidebar of the page.

Internet Explorer may not be able to view the Web page with the .xht extension if the file resides on the computer.  If you upload the .xht file (and appropriate folder) to your Web server, then you will be able to view the Web page with your preferred browser (i.e., Internet Explorer, Mozilla/Firefox, Netscape 7+).  You will need to ensure that your Web server can serve documents with the extension .xht.  This can be accomplished by setting the appropriate MIME-type for your Web server.  For more information, please visit:
http://www.dessci.com/en/products/mathplayer/author/creatingpages.htm 
Creating Math Equations for Scientific Notebook

Scientific Notebook now allows the importing of RTF documents containing mathematical expressions created using MathType.  This process is useful if the final content is to be embossed as Nemeth Braille.  To import math equations into Scientific Notebook, it is necessary for content to originally be created in MS Word using MathType and saved in a .RTF format.  From within Scientific Notebook, it is possible to import the .RTF document and prepare the information for embossing.

MathType also provides an option to copy an equation from the MathType authoring tool directly into Scientific Notebook.  It is necessary to choose the translation type before moving a MathType expression into Scientific Notebook.

1.  Open the MathType equation editor and compose a mathematical equation.

2.  Select Preferences from the menu bar and choose Translators.

3.  Choose the radio button marked Translation to other language (text).  Choose the translator in the drop-down list that corresponds to the output of your choice.  For Scientific Notebook, you may choose any one of the “Tex” translators.

4.  Select OK.

5.  Select the equation you wish to copy into Scientific Notebook and choose Copy (under Edit on the menu bar).

6.  Switch to Scientific Notebook and select Edit from the menu bar.  Choose Paste Special.  You will need to select the Text format and the radio button marked Internal Format.

7.  Select OK.  You may need to clean up part of the equation in order to ensure the entire equation is recognized as “math”, however, your equation should now be usable from within Scientific Notebook.

MathType and DotsPlus

In order to print mathematical content in the Dots Plus format, it is necessary to use the Tiger font (from View Plus Technologies), and the MathType editor.  Math equations can be created in MS Word from MathType.  When the document is ready to be printed to the Tiger embosser (from MS Word), the user needs to select the Tiger font.  This will allow for content to be properly embossed in the Dots Plus format.  For more information on the Tiger embosser, visit:  http://www.viewplus.com/
Resizing Equations in MathType

“Design Science Technical Support” <support@dessci.com> 2/26/2007 
Good afternoon,

The process for [enlarging equations] is essentially a 2-part process. You would first use MathType to create a “Preference” file and then apply that preference to the existing Word document. Here’s what you do.

Making a preference file:

1. Open MathType on its own.

2. From the Size Menu choose Define

3. The very top size category is called “Full” this is what all the others follow so you’d only have to change this one. Set it to 24 point.

Click OK.

4. From the Preferences menu choose Equation Preferences/Save to file.

5. Name and save the file in the default location.

6. Close MathType.

Note, you can make as many preference files as you like. Call them, 24point, 36 point, etc.

Applying the preference file

1. Open the Word document

2. From the MathType menu in Word choose Format equations 3. In the resulting dialog, click the radio button next to MathType preference file then click the browse button.

4. Find the preference file you want and double click to select it.

5. Click ok.

This will apply the size attributes saved in the preference file to each MathType equation in the document and end with a dialog that tells you how many objects were changed. Done!

Thank you,

Karl Valentine-Rothenberg

Technical Support

Design Science, Inc.

140 Pine Avenue, 4th Floor

Long Beach, California  90802

USA

Tel:  (562) 432-2920

Fax:  (562) 432-2857

support@dessci.com

www.dessci.com 
Many commonly reported problems are addressed on our website. You may view our Technical Support Notices at http://dessci.com/en/support/support/tncentral.htm 
MathTalk

Publisher:

Metroplex Voice Computing, Inc.

P. O. Box121984

Arlington, Texas 76012

fax: 817-543-1103

email: mathtalk@mathtalk.com
Retail Cost:

MathTalk bundled with Scientific Notebook: $295

MathTalk bundled with Scientific Notebook and Dragon Preferred: $495

MathTalk bundled with Scientific Notebook and Dragon Pro: $1020

System Requirements:

· Dragon Naturally Speaking 7.0 & 8.0 & 9.0 
· 1.5 MHZ PC; * Intel Pentium 4 for Dragon 9.0 
· 1GB free hard disk space for Dragon 9.0 
· Microsoft Windows XP (SP1 or higher) Home and professional, 2000 (SP4 or higher) for Dragon 9.0 
· SoundBlaster or compatible soundcard 
· 512 MB RAM minimum; * recommended 1 GIG RAM  for Dragon 9.0 
· Microsoft Internet Explorer v.5 or higher (free download from www.microsoft.com) 
· CD-ROM drive for installation 
· Web connection is required for activation 
Description

MathTalk can be used with Scientific Notebook and Dragon NaturallySpeaking to allow hands-free entry of math equations on the computer.

Product demos are available on their Web site:

http://www.metroplexvoice.com/demos.htm
LaTeX

Publisher:

Varies: numerous free editors

Retail Cost:

Numerous free editors and others at low cost

System Requirements:

Varies: some editors are cross-platform, at least one is Web-based.
TEX is a typesetting language created by Donald E. Knuth; it has extensive capabilities to typeset math. LATEX is an extension of TEX designed by Leslie Lamport; its major features include a strong focus on document structure and the logical markup of text; automatic numbering and cross-referencing. The term LaTeX refers only to the language in which documents are written, not to the text editor itself. In order to create a document in LaTeX, a .tex file must be created using some form of text editor. While many text editors work, many people prefer to use one of several editors designed specifically for working with LaTeX. 

There are a number of these editors available for free.
· Led: http://www.latexeditor.org/
· Texmaker: http://www.xm1math.net/texmaker/ (cross-platform)

· Keynote: http://evolve.lse.ac.uk/software/EquationEditor/ (Apple)

· AMS-LaTeX: http://www.ams.org/tex/amslatex.html
· Web-based: http://www.monkeytex.com/
The American Mathematical Society has a free PDF manual available online for learning LaTeX: 
· http://tex.loria.fr/general/mil.pdf
Web-based LaTex resource:

http://www.artofproblemsolving.com/LaTeX/AoPS_L_About.php
To help you get a general idea of LaTeX, I copied an example from Wikipedia.

The example below shows the LaTeX input:

\documentclass[12pt]{article}

\title{\LaTeX}

\date{}

\begin{document}

  \maketitle \LaTeX{} is a document preparation system for the \TeX{} 

  typesetting program. It offers programmable desktop publishing 

  features and extensive facilities for automating most aspects of 

  typesetting and desktop publishing, including numbering and 

  cross-referencing, tables and figures, page layout, bibliographies, 

  and much more. \LaTeX{} was originally written in 1984 by Leslie 

  Lamport and has become the dominant method for using \TeX; few 

  people write in plain \TeX{} anymore. The current version is 

  \LaTeXe.

  \newline
  % This is a comment, it is not shown in the final output.
  % The following shows a little of the typesetting power of LaTeX
  \begin{eqnarray}
    E &=& mc^2                              \\

    m &=& \frac{m_0}{\sqrt{1-\frac{v^2}{c^2}}}

  \end{eqnarray}

\end{document}

This input would produce the following LaTeX output:
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KETEX is a document preparation system for the TEX typesetting pro-
gram. It offers programmable desktop publishing features and extensive fa-
cilities for automating most aspects of typesetting and desktop publishing,
including numbering and cross-referencing, tables and figures, page layout,
bibliographies, and much more. KTEX was originally written in 1984 by
Leslie Lamport and has become the dominant method for using TEX; few
people write in plain TEX anymore. The current version is IXTEX 2¢.

E = mc (1)
m = ——— (2)




Because LaTeX is created completely with text-based commands, the underlying source code is readable with a screenreader. Many blind mathematicians and blind higher-math students work in LaTeX directly and then use the LaTeX editor to print out well-formatted math equations for their instructors.


Scientific Notebook

Publisher:

MacKichan Software

http://www.mackichan.com/
19307 8th Avenue

Suite C

Poulsbo, WA 98370-7370

Phone: 360-394-6033

FAX: 360-394-6039
For customer service:

info@mackichan.com
Retail Cost:

Full Price (Academic):  $148.00

Upgrade Price (Academic):  $52.00

System Requirements:

· Microsoft Windows® XP, 2000, Me, 98, or NT 4.0 or Apple Macintosh® running an emulator program such as Virtual PC™

· 64 MB of RAM

· 70 to 250 MB hard disk space, depending on the type of hard drive and the installation options selected

· CD-ROM drive

Description

Scientific Notebook is a math “word-processor” allowing authors to integrate mathematical expressions, text content, and graphics into one document.  Using the computer algebra engine MuPad 2.5, Scientific Notebook provides the flexibility to not only create mathematical expressions, but also solve equations within the document itself.  Scientific Notebook also provides the capability to compute symbolically or numerically, integrate, differentiate, and solve algebraic and differential equations. With menu commands, you can create 2-D and 3-D plots in many styles and coordinate systems; import data from graphing calculators; and compute with over 150 units of physical measure.

Scientific Notebook now allows exporting in RTF, MathML, and HTML as well as reading MathType mathematics by importing RTF documents.  Previous features including LaTex and PDF support are also included in Scientific Notebook.

Scientific Notebook Shortcut Keys

Note: When working in Scientific Notebook, go to View > Toolbars and turn on the Standard, Math Templates, Symbol Panels, and Tag toolbars.

	To enter
	Press 

	Toggle math/text
	Ctrl+m or Ctrl+t or Insert

	Fraction
	Ctrl+f or Ctrl+/ or Ctrl+1

	Radical
	Ctrl+r or Ctrl+2

	Superscript
	Ctrl+h or Ctrl+ up arrow or Ctrl+3

	Subscript
	Ctrl+l or Ctrl+down arrow or Ctrl+4

	Integral
	Ctrl+i or Ctrl+8

	Summation
	Ctrl+7

	Brackets
	Ctrl+9 or Ctrl+0 or Ctrl+( or Ctrl+)

	Square brackets
	Ctrl+[ or Ctrl+] or Ctrl+6

	Angle brackets
	Ctrl+<

	Braces
	Ctrl+{ or Ctrl+}

	Display
	Ctrl+d

	Product
	Ctrl+p

	Absolute value
	Ctrl+\

	Norm
	Ctrl+| (Ctrl+Shift+\)

	Required space
	Ctrl+spacebar

	Nonbreaking space
	Shift+spacebar

	Thin space
	Ctrl+,

	Thick space
	Ctrl+Shift+spacebar

	“ (double open quote)
	Single open quote (`) twice

	“ (double close quote)
	Single close quote (`) twice

	- (intraword dash or hyphen)
	Hyphen (-)

	-- (en dash)
	Hyphen (-) two times

	--- (em dash)
	Hyphen (-) three times

	- (discretionary hyphen)
	Ctrl+ -- (Ctrl + hyphen two times)

	¿
	? followed by ` (open single quote)

	¡
	! followed by ` (open single quote)


Hint: Scientific Notebook does not normally allow you to use the space bar in equations. You can use keyboard shortcuts to enter spaces:
CTRL + spacebar = required space
SHIFT + spacebar = nonbreaking space
CTRL + SHIFT  + spacebar = thick space

MathType to Scientific Notebook

- Open MS Word and create equations with MathType

- Set the MathType Translator to the following: Tex – LaTex 2.09 or Later (located under Preferences > Translators)

- Double-click on the equation to open in the MathType window and then select the entire equation

- Copy the equation (Ctrl+C)

- Open Scientific Notebook and choose Edit > Paste Special

- Choose Text > Internal Format

That should paste the equation into Sci. Notebook correctly.  You *might* need to ensure that the equation is rendered in red (as this marks it as Math content), but it should come across correctly.

Exporting Graphs to Word
We need to adjust the settings so that the graph does not have a frame, axes are not labeled, and tick marks are not numbered. We will add numbers and labels in the Braille font in Word.

(Note: If you do not have the Braille font, you can download it for free from Duxbury: http://www.duxburysystems.com/.)
Once you have created your graph, right click on it and choose Properties. Set the Axes so that tick labeling is disabled (check the disable tick labeling option).
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Set the layout to “plot only” so that there is no bounding frame around the graph.
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Under Item Plotted, set line thickness to medium.
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Select and copy the graphic and copy it. Open Microsoft Word and paste the graphic by going to Edit > Paste Special > Picture. 
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With the graphic in Word, enter the Braille labels in text boxes (26 point Braille font, no line around the boxes).
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 List of AT Products with Math Support

Courtesy of Design Science

www.dessci.com

Which Assistive Technology Products Have Math Support?

There are a growing number of assistive technology (AT) products that have math support, ranging from synthetic speech output of math equations to braille support. Design Science is constantly working with AT vendors to assist them in developing accessible math supports for their customers. We provide the following list to help keep you informed on the current status of math support in AT products.

· Reader Tools 

· Tactile and Braille Translation Software 

· DAISY Playback Software 

· DAISY Production and Conversion Tools 

· Authoring Software that supports DAISY or XHTML+MathML Export 

· Terminology Key 

· Instructions to Vendors 

Note:  The features listed are for the most current version of the software. Older versions may or may not have these features.

Reader Tools

The following table lists a number of the most popular synthetic speech reading tools, including screen reader applications and literacy support tools.

	PRODUCT
	VENDOR
	Accessibility Partner
	Basic Math Speech
	Advanced Math Speech
	Synchronized Math Highlighting
	Refreshable Math Braille Support 

	Browsealoud
	Texthelp
	Yes
	Yes
	No
	Yes
	N/A

	ClaroRead for PC
	Claro
	No
	Yes
	No
	No
	No

	HAL
	Dolphin
	No
	Yes
	No
	N/A
	No

	JAWS
	Freedom Scientific
	No
	Yes
	No
	N/A
	No

	Kurzweil 1000
	Kurzweil
	Yes
	Coming soon
	No
	N/A
	No

	Kurzweil 3000
	Kurzweil
	Yes
	Yes
	Yes
	Yes
	N/A

	MAGic with speech
	Freedom Scientific
	No
	Yes
	No
	No
	N/A

	NVDA
	NVDA-project
	N/A
	No
	No
	No
	No

	Read&Write Gold
	Texthelp
	Yes
	Yes
	No
	Yes
	N/A

	Supernova
	Dolphin
	No
	Yes
	No
	No
	No

	System Access
	Serotek
	Yes
	Yes
	No
	N/A
	No

	Window-Eyes
	GW Micro
	No
	Yes
	No
	N/A
	No

	WYNN
	Freedom Scientific
	No
	Yes
	No
	No
	N/A

	ZoomText Reader
	Ai Squared
	Yes
	Yes
	No
	No
	N/A


Tactile and Braille Translation Software

The following table lists some of the most commonly used translation software for the creation of hard copy tactile materials.

	PRODUCT
	VENDOR
	Accessibility Partner
	DotsPlus Math
	Math Braille
	Equation Editor Support
	MathType Support
	MathML Support

	Braille2000
	Computer Application Specialties
	No
	No
	Yes
	No
	No
	Coming soon

	Braille Maker
	Cragside AccessABILITY
	No
	No
	Yes
	Coming soon
	Coming soon
	No

	Duxbury Braille Translator
	Duxbury
	Yes
	No
	Yes
	Yes
	Yes
	No

	Tiger Software Suite
	ViewPlus
	Yes
	Yes
	Yes
	Yes
	Yes
	No

	WinBraille
	Index Braille
	No
	No
	Yes
	Yes
	No
	No


DAISY Playback Software

The following table lists some of the most popular DAISY Digital Talking Book software players.

	PRODUCT
	VENDOR
	Accessibility Partner
	Basic Math Speech
	Advanced Math Speech
	Synchronized Math Highlighting
	Refreshable Math Braille Support

	AMIS
	DAISY for All Project
	N/A
	No
	No
	No
	No

	Book Wizard Reader
	American Printing House
	N/A
	No
	No
	No
	No

	EasyReader
	Dolphin
	No
	Yes
	No
	No
	No

	eClipseReader
	IRTI
	No
	No
	No
	No
	No

	gh PLAYER
	gh
	Yes
	Yes
	Yes
	Yes
	No

	Victor Reader Soft
	HumanWare
	Yes
	No
	No
	No
	No


DAISY Production and Conversion Tools

The following table lists a number of commonly used production and conversion tools for creating DAISY Digital Talking Books, and in some cases for converting to other formats.

	PRODUCT
	VENDOR
	Accessibility Partner
	MathML Support

	Book Wizard Producer
	American Printing House
	N/A
	No

	CAST NIMAS Conversion Tool
	CAST
	N/A
	Yes

	DAISY Pipeline
	DAISY Consortium
	Yes
	Yes (requires MathDaisy)

	Dolphin Publisher
	Dolphin
	No
	No

	DTBMaker
	Wyoming Medical Center
	N/A
	No

	EasyConverter
	Dolphin
	No
	No

	EasyProducer
	Dolphin
	No
	No

	eClipseWriter Professional
	IRTI
	No
	No

	TechAdapt Accessible Media Center
	TechAdapt
	No
	Yes


Authoring Software that supports DAISY or XHTML+MathML Export

The following table lists document authoring software that can be used to create DAISY or XHTML files with accessible math.

	PRODUCT
	VENDOR
	Accessibility Partner
	Supports DAISY Export w/Math
	Supports XHTML+MathML Export

	MS Office Word
	Microsoft
	No
	In Beta (requires “Save as DAISY XML” add-in) 
	Yes (requires MathType)

	OpenOffice Writer
	OpenOffice.org
	N/A
	Yes (requires Text To DAISY DTB" extension)
	Yes (requires "Writer2html" extension)
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